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 1 Introduction

 1.1 About

Welcome to the user guide for the Veesus Point Cloud Plugin for Rhino.

At the core of the plug-in is our unique point rendering engine that enables the rapid 
loading and visualisation of unlimited point cloud data sets – the XStreamEngine. The 
XStreamEngine powers all Veesus products, including our fully-featured standalone point 
cloud editing tool, Arena4D. 

This user guide will help you understand how to use the features of this plug-in, which can 
only be used in McNeels’ Rhinoceros tool. If you find you have any issues or questions 
which this guide doesn’t answer, you can contact us at support@veesus.com. 

 1.2 Installation

Point Clouds for Rhino is an add-in for Rhino, and
therefore will not run outside of Rhino. To install the
software, first run the setup wizard and follow all the
steps and on-screen prompts during the installation
process 

Select the directory to install the software:  Shown
is the default for Rhino 6.
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If you’ve previously installed a demo licence
on your machine and you are now 
upgrading to a full licence you will still need 
to run the installation. When the option 
appears in the wizard, select “Reset 
Licence”. Under no other circumstances 
select this option. If in doubt, continue the 
installation without the option selected 
and contact Veesus support. 

. Once finished: 

• Load Rhino 

• From the “Tools” menu select “Options...” 

• Select “Plug-ins” from options menu

• Select “Install...” button from plug-in list

Locate the Veesus.rhp file (default location is shown below): 

Click “Open” once file is highlighted as above. 
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Once loaded ensure the plugin is Enable.  If it is not loaded, right click on it and select 
“Load Plugin”:

Select “OK” to close the “Rhino Options” menu.

Note: the above may differ slightly for Rhino 5.0 and Rhino 7.0

Load the Veesus Point Clouds User Interface: type 
“VeesusPointClouds” into the Rhino Command Line.

Position the loaded VeesusPointClouds window as required.

Finally restart Rhino if requested.
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 1.3 Rhino Settings

Arena4D makes extensive use of advanced OpenGL functions.  Therefore it is important to
ensure that “Use accelerated Hardware mode” is active under the main View options of 
Rhino 5, or Rhino 6 “GPU Tessellation”:

 1.4 Data Formats

Arena4D for Rhino requires point clouds data to be in the Veesus VPC format.  To 
generate a VPC file you need to use the standalone VPC Creator which can be download 
for free from the Veesus website.

 1.5 Loading & Saving

All Arena4D options are saved into the Rhino document.  However the point cloud is saved
as a reference, therefore if you move or delete the VPC file after saving the document it 
will not be loaded the next time you open it with an on screen notification.
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Professional Version only in blue:

 1.6 Installing Veesus Point Cloud Render Plugin

Note: the following sections only applies to the Professional version of the plugin

Veesus Point Cloud Render for Rhino installs as a plugin through the Rhino plugin 
architecture.  To do this first perform steps: 1.2 Installation.

• Load Rhino

• From the “Tools” menu select “Options...”

• Select “Plug-ins” from options menu

• Select “Install...” button from plug-in list

Locate the VeesusRender.rhp file (default location is shown below): 
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Once loaded ensure the plugin is Enable and Loaded.  If it is not loaded, right click on it 
and select “Load Plugin”:

From the “Render” menu select “Current 
Renderer” option followed by “Veesus Point
Cloud Render”: 
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 2 General Work Flow
Once point cloud(s) are loaded into the Arena4D plug-in the following steps might form 
part of a general workflow:

• Orientate the point cloud.  Section: 3.3.2 Align

• Set the point cloud Origin.  Section: 3.3.1 Origin

• Professional version only: Clean the point cloud (delete)

• Perform a Shader for quick inspection of elevation changes.  Section: 3.7 Shader

• Perform Slices and Clipping.  Section: 3.5 Slices and 3.6 Clipping
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 3 User Interface

 3.1 General

The Arena4D user interface is very simple and consists of a number of control tabs which 
separate the key functional parts of Arena4D into separate sections.

In each section there will be three common buttons.

The “+” button adds an item to the current list, “-” button removes.

 3.2 Point Clouds

When a point cloud is added and selected in the 
displayed list, a number of options become available 
which control the appearance of that point cloud in the 
Rhino view windows.

Quality – determines the density of the rendered point 
cloud.  The higher the quality the better the appearance, 
but the slower the performance.

Point Size – The size of points.

Render – Draw using Intensity, Colour or Ramp values.

Filing – Fills gaps in the point cloud data by intelligently 
sampling the point data.

Ratio – Controls the power of the filling setting for 
distance.

Opacity – The transparency of the selected point cloud(s).

Brightness – The brightness of the selected point 
cloud(s).

Contrast – The contrast of the selected point cloud(s). 

Zoom button centres the Rhino views on the 
currently selected point cloud(s).

Restore button restores point cloud deletions.

Clash Detection detect clash between point clouds 
and meshed surfaces see: 3.8 Clash Detection

Server button see section: 5 Arena4D Point Server

X – Position of this axis

Y – Position of this axis

Z – Position of this axis

Scale – Adjust the displayed size of the selected point 
cloud(s).  Can be scaled up or down.

Align – Tools used to manipulate the point cloud(s) position and rotation see: 3.3 Align
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 3.3 Align

Tools used to position and rotate selected point cloud(s)
within Rhinoceros own local coordinate system.

 3.3.1 Origin

Position a Rhinoceros “Single Point” on the selected
point cloud.  Select the created point highlighting it yellow and
select the Origin icon.  The point cloud will be moved to X,Y,Z
0,0,0 centred on the selected point.

 3.3.2 Align

Create two Polylines horizontal
and vertical (horizontal MUST be created
first) each representing a new axis for the
selected point cloud.  Select both polylines
highlighting them yellow and select the 
Align icon.  The point cloud will transition
relative to the new axis.

Note: use Axis, Flip and Rotate to correct
the orientation. 

 3.3.3 Reset Position

Resets any of the align or origin
operations back to the point cloud(s)
original loaded location/rotation.

 3.3.4 Axis

Select which axis Flip and Rotate are applied to X,Y or Z.

 3.3.5 Flip

180° flip selected point cloud(s) around selected axis. 

 3.3.6 Rotate

90° flip selected point cloud(s) around selected axis.
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 3.4 Options

The options panel features settings that 
affect all point clouds.

Lighting – Adds dynamic lighting to the 
scene with the light source behind the 
current eye position.

Rendering – Removes VPC point cloud(s) 
from the view displays.

Snap – If “Point” is enabled under the “Osnap” settings of Rhino then Arena4D will allow 
Rhino to snap to the closest point nearest the cursor in the point cloud.

 3.5 Slices

Slices are a way to quickly visualise a section through the point cloud.  Slices can only be 
created on orthogonal views and not on the main perspective view unless using the Two 
Point Slice:

The slice is visualised in the viewing windows by a solid line passing through the data.

Above and below the 
line are dotted lines 
representing the width 
of the slice. 

The slice can be 
manually moved by 
clicking and dragging 
the solid slice line or 
section: 3.5.10 Step 
Slice.

A slice is applied to the currently active view when added.

It is possible to have multiple slices active at any one time, so long as they are not in the 
same view.

12 of 25



                                  Arena4D For Rhino – User Guide

Each slice has the following properties:

Lock - prevent slice from being moved.

Colour - select individual colour. 

Name - meaningful names can be applied.

Width - in units of current document.

Perspective - enable whether you want 
the slice effect to be visible in the main 
perspective view.

Attach - attached construction at the Slice 
when turned on.  Turn off, move slice and 
construction will stay at previous Slice 
position.

Clipping - effect the selected points within 
clipping.

Highlight - whether the slice is highlighted
at all times.

Native - allow the slice to also effect native
Rhino objects.

At the top of the slice window are two buttons:

 3.5.1 Two Point Slice

Creates a slice between two user points and is useful for slicing the data if not 
aligned to the construction plane.  Click two points inline where the slice is required.

 3.5.2 Slice From Plane

Adds the selected slice from the “Named CPlanes” tab to
the Slice tab within the Arena4D plugin.  First a slice must have
been added to the named cplanes tab, see section: 3.5.7 Plane 
From Slice.  Make sure Named Cplanes is turned on by right
clicking on “Arena4D” tab and selecting “Named Cplanes”.

Select the “Named Cplane” tab
followed by the Cplane slice to be
added and it will be shown in the
Rhino views as three axis.  Now click
the slice from plane icon 
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At the bottom of the slice window are seven buttons: 
Professional Version only in blue:

 3.5.3 CSV (Plane Analysis)

Creates a text based CSV (Comma Separated Values) file containing X,Y,Z - 
R,G,B – Intensity - Classifications – Distance (from centre of slice outwards in 

both directions). 

 3.5.4 Vector

With a slice positioned as required, make the viewport full and select Vector.  The 
resulting Rhino drawings will be centred around the middle of the sliced data.  These 
drawing can then be exported from Rhino into any format you require.

 3.5.5 Outline

With a slice positioned as required, make the viewport full and select Outline.  The
resulting Rhino drawings will be outlined around the middle of the sliced data.  These 
drawing can then be exported from Rhino into any format you require.

 3.5.6 Position Slice

Click directly where to position the slice within the active slice.

 3.5.7 Plane From Slice

Adds the currently active slice to the “Named Cplanes”
Newly created Cplane(s) can be seen under the Named
Cplanes tab.

 3.5.8 Position Slice Between Two Points

Select the two outer limits of a slice to position it in the middle of those limits.

 3.5.9 Align To Curve

The polyline icon allows you to convert a Slice from a traditional orthogonal slice to one 
that aligns with a curve. To use this feature you must have first added a curve or line to the
data.  Select the slice to Align then by clicking the “Align To Curve” button and clicking 
anywhere along the curve or line will align the view and slice (and optionally the 
construction plane) to that point on the curve. Note: the curve or line (any Rhino object)
must NOT be selected before clicking the “Align To Curve” button.
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 3.5.10  Step Slice

The left and right buttons step the currently selected slice by it's current step setting.

 3.5.11 Attach to Plane

Aligns the view construction plane with the slice position.

“Attach To Plane” means that the construction plane in the slice view will follow the 
movement of the slice if enabled.
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 3.6 Clipping

The clipping tab is used to select areas of 
point data that you wish to hide or unhide.

The four main controls of the Clipping tools 
are Select, Unselect, Invert and Remove as 
represented by these
icons:

Select activates the clip tool in the current 
active window. Use the left mouse button to 
add points to the clip polyline and the right 
mouse button to end the selection.

All data within the polyline will be selected.

Unselect works in the same way but 
unselects everything within the polyline.

Invert toggles the effect of the select and 
unselect tool. Instead of selecting everything 
within the polyline they will select everything 
outside the polyline.

Once data is selected it will turn green in the 
main viewing window.

Remove selected clip(s).

At the bottom left of the clipping panel are 7
buttons. 

Select All selects all the points in the
currently enabled point cloud(s).

Clear unselects all the points in the currently enabled point cloud(s).

Invert inverts the current selection.

Hide will make selected points become invisible/visible.
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Professional Version only in blue:

Delete selected points from the point cloud (use clips to select the area).

Note: to restore the point cloud back to how it was original created with the VPC 
Creator see section 3.2  Point Clouds “Restore”.

Copy selected points (use clips to select the area) to a new Veesus Point Cloud (VPC).  
File name will be request.

Plane Through Points adds the currently active clip to the “Named Cplanes”  Newly 
created Cplane(s) can be seen under the Named Cplanes tab.

As well as creating individual clips you can group a series of clips into a clip 
group. For example you may have taken a number of selections to isolate a chair
in a room. You can select all these clips and create one single clip group by 

pressing the create clip group button. 

Individual clips or clip groups can be applied at any time by either double
clicking them in the list, or clicking the process button opposite the table. 

Delete Selected deletes all individually selected clip(s) and in the group section 
deletes all individually clip group(s).  Note: Does NOT unselect all the points in 
the currently enabled point clouds.  For this to happen select the Clear 
button.

 3.6.1 Point Clouds

Arena4D provides the ability to convert areas of point cloud(s) from the Arena4D plugin 
into a native Rhino point cloud object or save as a Arena4D VPC file.

Using the clipping tool to highlight an area of interest, select either Rhino
or File from the option at the bottom right of the screen and press the
cloud icon.

 3.6.2 Clipping In Slices

If an active slice and its “Clipping” tick box is turned on whilst performing a clip operation, 
only data within that slice will be effected.

For example a slice could be cutting through the floor of a room, meaning only the floor is 
visible.  Creating a new clip whilst this slice is active will ensure only data from the floor is 
selected.
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 3.7 Shader

The shader panel provides control 
over the planar shader. This is a 
capability which colours data along a 
plane normal vector from the 
construction plane out.

The shading is enabled per view. Once
enabled/disabled in one view you can 
apply this to all others by clicking the 
four arrow button in the top right 
corner.

Once enabled you can change the 
shaders direction by changing the XYZ
values of the normal vector. XYZ 
should add up to ‘1’ so if your point 
cloud was aligned true to the 
construction plane, the value 0,0,1 
would shade on the Z axis (up).  If 
your point cloud is not true to the 
construction plane then values of 
0.054,-0.041,0.998 for example may 
provide a the alignment (yours will be 
different).

A simpler option is to align the shader to the view direction.  Pressing the eye
icon will set the XYZ values for you and set the shader “zero” point to be your
construction plane position in that view.

Range – The distance over which the shader will calculate values.

Offset – The distance from the shader zero point to start calculating from. Useful for 
moving the shader along the axis without changing the construction plane.

Repeat – How the shader should act once it has gone beyond either the start or end 
location as calculated by Range + Offset:

• Clamp, continue with first/last colour.

• Stop, don't apply colours beyond range.

• Repeat, loop through colours again.

Colours – You can chose between your own custom colour palette in the shader, or to use
the entire RGB hue values.

Blend – Effect of shader on point colours.
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 3.8 Clash Detection

When Point Clouds and Meshed Surfaces come into
contact, the clashed areas will be highlighted with a red cross.

Turning the Clash icon on/off will display or remove clashed arears.

Note: visual performance will be reduced with clash enabled.

 3.9 Viewpoints

Viewpoints are a fast way of 
repositioning your view position in 
each view.

If you have a view positioned in a way 
you would want to recall later, click the 
Add button to save it.

To remove viewpoint(s) highlight and 
click the remove button. 

Double clicking a saved viewpoint, or 
selecting it and pressing the tick
button will put all the views back to 
their saved positions.
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 3.10 Rendering VPC Files

Veesus Point Clouds can be rendered within Rhino using the Arena4D Render plugin.  
First select the Render Properties from the Render pull down menu, specify both the 
resolution and backgroud colour.  Note: resolution is limited unless a licensed plugin 
is used.

Selecting Render Preview will produce a quicker
render of the point cloud(s) and Render will produced
the most detailed render.  Note: higher the resolution
and more point cloud points the more time it will
take for the rendered image to appear.

Functions within the Render window such as Exposure and Post Effects operate in the 
same manor as the standard Rhino Renderer.
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 3.11 Point Cloud not displayed correctly

There are conditions that may stop a point cloud being displayed:

• If the point cloud is not displayed correctly in the shaded view, try turning off 
“ground plane” within Rhino.

• Arena4D Data Studio is capable of generating “protected” VPC files. These disable 
export functions and optionally add an expiry date to the data. Once the expiry date 
has passed you will no longer be able to view the data.

If your point cloud data is not visible, check with the VPC provider whether they 
protected and enforced an expiry data on the files you were provided.
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 4 ZAPPCHA

Users with access to Zappcha can stream point cloud data stored in The Zappcha Cloud 
to Point Clouds for Rhino. This means you can work on point clouds without having the 
point cloud data on your computer.

NOTE: you need an active Zappcha account to use this feature. To create your 
Zappcha account for free, please visit Zappcha.com.

To access Zappcha, first select the 
Zappcha tab.

Enter your username and password.

Click the cloud button to log in to the 
Zappcha Cloud.

Moving back to the Point Clouds tab, 
clicking the cloud icon  will launch the

Point Streams window.

In the Point Streams window, select the 
Zappcha tab. You will see all the point 
clouds you have saved to your Zappcha 
Cloud.

Click on a point cloud in the list to select 

it, and simply click Open to start 
streaming that point cloud to your viewer. 
Once it has loaded, the point cloud can 
be worked on in exactly the same way as
any other point cloud. The red cross 
button next to it closes the window.
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 5 Arena4D Point Server

For owners of or permitted access Arena4D Point Server(s) you can stream data to 
Arena4D for Rhino.

To access to Arena4D Servers first select the Point Cloud tab.

Clicking the Open Point Stream 
button will launch the Point Server
Manager

To add a new server enter 
the URL of the server 
including the port number, 
then click the 

Add button. 

For example 127.0.0.1:10123

Once the server is added it 
will appear in the list of 
available servers. 

Selecting a server will 
produce a list of point clouds 
on that server in the right 
hand side. Once a point 
cloud is selected from the
server simply click Open

to start streaming that data to your viewer.

Streamed point clouds can be manipulated in anyway a normal point cloud file can be. 
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 6 Scripting

It is possible to control a number of Arena4D functions via RhinoScript. 

Note: Slices can be added by point or by width, to understand the difference please 
refer to the slicing section for more details.

public void SetPointCloudsVisible( bool visible)

public void AddSlice( int red, int green, int blue, double step, double 
width, bool colourPoints, bool clipping, bool locked) 
public void PositionSlice( bool width) 
public void PositionSlicePoint( object position)
public void PositionSliceWidth( object positionList) 
public void EnableSelectedSlice( bool enable) 
public void MoveSlice( bool positive) 
public void SetActiveSliceByView() 

public void AddClip()

public void AddViewpoint()
public void SetPointSnap( bool on) 

public void OpenPointCloud( string path, int pointSize, float quality, int 
colourMode) 
public object ListPointClouds() 
public void RemovePointCloud( int index)

public object GetSelectedPoints()
public void SelectAllPoints() 
public void ClearSelectedPoints()
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Example

Option Explicit 

Dim customobj 

On Error Resume Next 

Set customobj = Rhino.GetPlugInObject("{904b9f2e-f13f-4021-be5f-0318da03cc70}") 

If Err Then 

MsgBox Err.Description 

Else 

customobj.AddSlice 

End If

Note: check the GUID shown above as 904************************* on your specific 
installation of Rhino:

Tools→Options→Plug-ins→Veesus Point Clouds for Rhino→Details:
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